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Preliminary Note - about this document

This dissemination plan describes in detail the dissemination activities planned by the consortium

of the PreDys project. It includes all important aspects of planned dissemination activities, defines

dissemination phases and presents planned material and tools to be prepared in order to

disseminate information on the project. It aims to define the dissemination goals as well as the

project’s target audience and channels through which the project results are going to be

promoted. The dissemination plan constitutes the starting point of the whole dissemination

process and will be complemented and revised on the basis of partners’ input in the first months

of the project.

Proper project dissemination is a key in order to ensure the maximum impact of PreDys project.

This deliverable outlines PreDys dissemination strategy in terms of identification and description of

the dissemination key elements:

● the objectives (why, mission & vision);

● the subjects (what);

● the target audience (to whom);

● the timing (when);

● the tools and channels (how);

● the responsibilities for dissemination (who will perform the dissemination);

● the way to evaluate and assess the impact of the dissemination activities.

Consortium:

Name Role Country Short name

Escola A. Aguilera Coordinator Spain --

Sdruzhenie

"asociacia Dyslexia -

Bulgaria"

Partner Bulgaria DABG

Kocaelil Milli Egitim

Mudurlugu Partner Turkey KpDONE

Rezeknes tehnologiju

Akademija Partner Latvia RA

Agrupamento de

Escolas de

Mangualde

Partner Portugal Edufor

4th primary school of

Heraklion

Partner Greece --
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1. PREDYS IN BRIEF

The objective of the project is developing a set of training materials for pre-school teachers and

parents in order to equip them with proper knowledge and understanding of characteristics of the

child’s development at the pre-school age, as well as a set of practical advices and exercises for

initial formation of the study skills in each child depending on his individual needs. This way the

consortium aims at supporting pre-school teachers and parents of pre-school children during the

transition between the pre-school and primary school, so even the children who are at “risk of

dyslexia” have a smooth and easy transition period and they have the opportunity to reach their

potential in the new learning environment.

The project partners plan to develop not just some separate materials, but a complete Transition

Support Kit, starting from a Check list for school readiness (that will help pre-school teachers to

define those children who are at “risk of dyslexia”), a Guide Book for pre-school teachers, a Guide

Book for parents of pre-school children, and a Set of Worksheets with exercises and ideas of

different activities that will help both teachers and parents to provide effective support to children

during the period of transition between pre-school and primary school. By implementation of

project activities and outputs, the image of the institutions in local and professional community

will improve, increasing the scope and quality of its services.

Research shows that the problems associated with learning disabilities (LD), and particularly with

dyslexia can be considerably decreased if there is an early intervention - the preschool age is vital

as children develop at a much faster rate from birth until they start school. Development of the

basic skills at an early age that are the prerequisites for literacy, school-related skills and other

skills which are necessary in today's competitive world. Although it is not possible to diagnose a

child with dyslexia before he starts the process of literacy acquisition (1st grade of primary school),

there are lot of signs that place some children in a group of those who are at “risk of dyslexia”.

These signs are well known to the specialists working on the field and if recognised and addressed

early enough, they would prevent such children of struggling to learn to read and write when they

start school.

As far as the materials developed within this Partnership will be in six languages (including English),

they will be available to much wider audience beyond the partner countries, which will

considerably increase the impact of the project results at European level, moreover the topic in

question is considered important almost in every country. All resources produced by the partners

will stay available (via project FB page, partners’ websites) even after the end of the project period

for every interested user.
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Criteria for success

PreDys project determined as quantitative success criteria the following:

● Training materials for pre-primary and primary school teachers ( Teachers' Guide) and for

parents ( Parents' Guide ) and set of worksheets (at least 30);

● Number of the participants attending the piloting course: 120 altogether within the

partnership (60 per partner country: 30 pre-primary and primary school teachers and 30

parents );

● Number of transition students with dyslexia involved: at least 180 altogether within the

partnership(30 per partner country);

● Number of children at the last year of pre-primary school involved in activities: at least 90

altogetherwithin the partnership (15 per partner country);

● Number of parents involved - at least 30 per country - 180 altogether;

● Number of Transition KIT downloaded - at least 60 per country - 360 altogether;

● Number of conference attendees (at least 40 per country - 240 altogether)

Qualitative research field survey will be done in field survey method including:

● surveys (using questionnaires) - at the end of the activities (Piloting courses , seminars,

outputs implementation ) all the partners will provide the Questionnaires of the Quality to

the participants so that we can determine the weak and strong points of the project and

take measure;

● focus group discussions practically on each stage of the project and the target groups

(teachers, specialists , parents, students, school administrators, educational authorities).

These methods will provide more detailed answers and certain information about the project

results.

The qualitative criteria evaluated at each of these times will be included in these evaluation

documents and will be expressed in the reports produced.

2. DISSEMINATION OVERVIEW

The following sections describe the main pillars of the dissemination  strategy: 

(i) why disseminate (goal and strategy);

(ii) subjects (what will be disseminated);
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(iii) target audience (who will most  benefit from the project  results and who 

would be interested in learning about the project findings);

(iv) the timing (when  dissemination will take place);

(v) dissemination players, tools and channels (who will disseminate and how to reach the

target audience).

2.1 Why disseminate

By “dissemination” we shall understand activities being aimed at spreading information and

promoting knowledge about the project and project results. By “dissemination plan” we shall

understand a plan of activities and methods for making the project results visible to a wide target

audience, as well as a plan for organising all additional actions necessary to efficiently promote

project objectives, outcomes, and results.

Dissemination is an ongoing process starting at the very beginning of the project, involving

showcasing the project’s activities and outcomes, as well as final results. Dissemination is the key

element of the project’s visibility and sustainability. Therefore the dissemination activities are a

focus area within the project’s duration in order to promote the project’s ideas, knowledge and

results, as well as the completed project outcomes and their future exploitation.

The general aim of this document is to describe in detail and then assist in the generation of an

effective flow of information about the project, its objectives and results.

The document will be revised at the very beginning of the project (developing the detailed plan of

dissemination actions, and preparing all relevant staff required to efficiently run dissemination

tasks). At the end of the project all performed activities and prepared material will be reported on

and summarised in the Dissemination Activities Report.

The purpose of the document is to plan the strategy of the network’s dissemination activities,

considering all the necessary staff and different dimensions of the dissemination process. That

requires:

● Definition of the network’s results

● Definition of the target groups and areas which shall be reached within dissemination

process

● Providing relevant dissemination material, maintaining and systematically updating it

● Identification of events relevant to the network’s area of interest and choosing the ones

where the network will be presented

● Plan of effective cooperation with the project’s target and focus groups
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The final objective of the dissemination activities is to promote the 

PreDys project and spread its results to the largest possible concerned audience (at the national, 

European and international level) in order to encourage the implementation  and use of

 the project 

results (exploitation), always considering the confidentiality and IPR protection aspects. 

In more detail, the general goals of the dissemination activities of the project are to:

● raise public awareness 

about the  project, its expected  results and progress within defined target groups;

● inform

make the outcomes developed through the PreDys project available to the different target

audience;

● exploit

enhance PreDys’ results, maximizing its potential

● engage

receive inputs and feedbacks from the various target groups;

● exchange

with projects and groups  working in the field in order to join efforts

and maximize potential;

● pave the way

for a successful education regarding reading and writing, contributing to a more successful

school;

● make sustainable

ensure that the outputs will be sustained after the end of the project lifetime

2.2 Subject of Dissemination

We pledge to disseminate by all possible means the results / knowledge gained within the

following intellectual outputs provided for in this project:

1. Pedagogical framework - Starting Period: Nov. 2019 - starting point for the project work

(and as a base for the Output 2). It is an important part of the quality plan as it states the

current situation in the partner countries, the needs of the target groups and the means

and methods to reach project’s goals and objectives;

2. PreDys Tool Kit - Starting Period: March 2020 - (including: Check list for school readiness,

Guide for teachers and Guide for parents and a Set of worksheets);

3. Piloting and evaluation of the developed materials – Oct 2020 - (including: teacher training,

parents training, workshops for teachers, supported by specialists apply materials with

children; parents also will be included):

3.1. Each of the partners will be responsible for recruiting a group of at least 30 teachers

to be trained to use the new developed tools;
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3.2. Before piloting, a didactic Pilot Guide will be developed; the aim of the Guide is to

provide partners with common standards for organising the pilot training. It will be

used only by partners, thus will be only in English;

3.3. A group of at least 30 parents of dyslexic students who are in the transition period

between pre-primary and primary school (last year of pre-school and 1st and 2nd

grade) will be identified;

3.4. For them will be organised a seminar; the Guide for parents will be presented and

parents will be instructed how to use them in order to provide better support to their

children. Parents will be selected on a voluntary basis;

3.5. Teachers who will be trained will take part in the second activity: implementation of

the Check list for school readiness and PreDys Tool Kit with their students in the

pre-school and primary classes, using the advices given in the Guide for teachers;

3.6. As a second part of piloting, a workshop for students and parents will be organised.

At least 30 children from pre-primary and 10 children from 1st grade with learning

difficulties will take part in this workshop in each country. The aim is to give the

participants an example of how the PreDys Tool Kit can be implemented in practice.

There will be also the following activities which will also be disseminated:

4. A training (in Bulgaria – Ruse | 3 full days | 3 representatives of each partner organization)

of small group of teachers (4 participants per country) – “PreDys Tool Kit - from theory to

practice” – Jan. 2021 - on how to use the new developed materials and how to implement

them in their work. Participants in the training will after its end play an active role in
organising and providing the Pilot training for teachers and parents in their country;
will present (together with the project team members) the PreDys Tool components to
their colleagues so that more teachers benefit from the new gained knowledge. After
the Pilot training they will lead the workshops with children;

5. Two study visits:

5.1. Study Visit 1 - in Portugal – Mangualde | 3 full days | 4 representatives of each

partner organization) – March 2021 - aimed at observing colleagues' work; sharing

ideas and experience; creating collaboratively some educational materials (worksheets).

It will cover visits to some mainstream kindergarden schools,

guidance/Research/Resource centers which are responssible for assesment and

guidance of the pupils and other essential institutions respective to the country visited

and visits to special education classroom environments (where possible);

5.2. Study Visit 2 – in Greece | 3 full days | 4 representatives of each partner

organization) - June 2021.

6. A Multiplier Event in each partner country – Sept. 2021 - Presentation of the project

outputs at national dissemination conference.
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2.3 Target Audience

According to the goal of the PreDys project, the target audience for 

the dissemination activities has been divided in the following groups: 

a. Policy makers

the end of this project will be the construction of an assessment and intervention kit for

students at risk for dyslexia. The struggle for a policy focused on tackling problems before

they become more difficult to overcome is long overdue. In schools, this intervention often

derives from the goodwill of the technicians who are there. This project aims to contribute

to the discussion, at least in partner countries, about the importance of an assessment and

intervention in reading and writing difficulties even before they are formally detected.

b. NGOs

we talk about organizations directly related to reading and writing, specifically Dyslexia, but

also organizations related to education, families, etc.

c. Schools, Training Centers, Higher Education

to maximize the level of productivity of the institutions – schools, training centers, higher

education responsible for teacher training - in each region and in each country. In

long-term, we want to contribute to the improvement of teachers professional

competences to prepare children to face the new challenges the school offers them, and to

help those who encounter difficulties to form and develop the skills necessary for smooth

transition from pre-school to primary school and for successful start of the school:

- Researchers

Researchers in the area of intervention in preschool education, reading and writing in

general and dyslexia;

- Future teachers

To warn future teachers - students attending courses to be teachers - including those who

will be pre-school teachers, about the importance of intervention of core competences for

the improvement of areas that would otherwise be compromised and would compromise

students' academic success;

- pre-school teachers

the pre-school age is vital as children develop at a much faster rate from birth until they

start school. Development of the basic skills at an early age that are the pre-requisites for

literacy, school-related skills and other skills which are necessary in today's competitive

world. It is therefore essential to provide early childhood educators with the knowledge

and tools to intervene with quality;

- SEN Staff

speech therapists, special education teachers, psychologists and other technicians working

on reading and writing issues (eg psychomotor practitioners);

- Other teachers

teachers working on reading and writing and teachers in general;
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- Parents

to Increase awareness among teachers and parents of the importance of early

identification of the possible learning difficulties of some children, and the important role

of early intervention. Parents can be a valuable helper in both detection and intervention.

We therefore consider it vital that the program proposed here contemplates them, thereby

minimizing the levels of anxiety and frustration at wanting to do something but not

knowing how.

2.4 Timing of Dissemination

Dissemination activities are planned in accordance with the stage of development in 

the project. Although a number of dissemination actions will  take place during the first  half of 

the project, the most significant dissemination activities will take place as final research of each

intellectual output  results is available.

The dissemination will follow the AIDA model: 

✔ Awareness to attract the attention  of the target audience;

✔ Interest of the target audience;

✔ Desire of the target audience to know more about the project;

✔ Action to lead the target audience towards get involved in the project and to promote its 

results  to  facilitate  their  exploitation. 

According  to  this  principle,  three  phases  are considered:

FASE 1 (Dec. 2019 – Sept. 2020)

Focused on increasing the visibility of the project and mobilising stakeholders and multipliers. 

At this phase, the main activities  will be related to the implementation of the dissemination 

tools (social networks,  visual identity), preparation of dissemination material, general 

presentations of the PreDys project, the distribution of publishable abstracts 

and progress resumes. 

FASE 2 (Oct 2020 – July 2021)

Focused on the dissemination of information related to intellectual output 1 (Pedagogical

Framework), 2 (PreDys Tool Kit) and 3 (PreDys Tool Kit - from theory to practice - how to

implement piloting). This data will be presented in journals, conferences and other media to 

alert the target audience of this project to the need for training/ information and practice changes
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in schools and other institutions with a voice in education issues. There will also be replication

events, either from the training or from one of the study visits (the first).

FASE 3 (Sept. 2021)

In this last phase, the moments of dissemination will focus on the dissemination of the entire

project’s results (multiplier event).

2.5 Dissemination Players, tools and channels

The following tables include the general activities that each Partner commits to, as mentioned

below. The specificity of this commitment will be explained in the National Dissemination Plan,

which will be built by each partner. Those documents are annexes to the present Plan.

Each partner is responsible for storing (for later use - in reports) information regarding the

following - activities whose implementation they are responsible for:

- Number and what kind of dissemination events;

- Type of dissemination (publications, events, etc.);

- Number of participations / views;

- Impact (assessment by participants, if applicable).

Using a document like the one in Annex 0 by each partner may be helpful.
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DISSEMINATION

ACTIVITY DATE
IMPLIED PARTNERS

LOGO Spain Bulgaria Portugal Turkey Latvia Greece

Create the

project logo
Dec. 2019 X

Project

presentation

associating it

with the logo in

the available

media

Dec. 2019 X X X X X X

DISSEMINATION

ACTIVITY FREQUENCY
IMPLIED PARTNERS

PUBLICATIONS Spain Bulgaria Portugal Turkey Latvia Greece

Facebook’s
project

publications
B X X X X X X

Facebook’s and
other social

media partners’
publications

A X X X X X X

Website’s
partners’/others

publications
A X X X X X X

Articles
(Send press

release to all
media accessible

- Annex 2) and
then keep

evidence of the
publication of

articles

E
F

X X X X X X

Flyers
Annex 3

For
dissemination
of the project
and specific

events

X X X X X X

Partners’
Newsletter

Annex 4

D X X X X X X

Use of European
e-learning

platform for
adult EPALE

E X
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(https://ec.euro
pa.eu/epale/)

Use of the
European school
community
eTwinning
platform
(http://www.et
winning.lt/ or
https://www.et
winning.net/lt)

E X

Use of "School
Education
Gateway, SEG
(http://www.sc
hooleducationga
teway.eu/lt/pub
/index.htm).

E X

Final handbook
for teachers

At the end of
the project

X X X X X X

Final handbook
for teachers

At the end of
the project

X X X X X X

Final handbook
for Principals

At the end of
the project

X X X X X X

Final handbook
for Counselors

At the end of
the project

X X X X X X

Transition Kit
(No. Of

downloads)

X X X X X X

DISSEMINATION

ACTIVITY DATE
IMPLIED PARTNERS

EVENTS Spain Bulgaria Portugal Turkey Latvia Greece

Replication of
training

Feb. 2021 X X X X X X

Replication of
study visit 11

May 2021 X X X X X X

Multiplier
event

Sept. 2021 X X X X X X

DISSEMINATION ACTIVITY IMPLIED PARTNERS

EXTERNAL EVENTS Spain Bulgaria Portugal Turkey Latvia Greece

Presentation of project
outcomes at Educational events

X X X X X X

1 No time to replicate study visit 2.
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(The more presentations the better)

DISSEMINATION

ACTIVITY

DATE

IMPLIED PARTNERS

ASSESSMENT

AND

REORIENTATION

OF

DISSEMINATION

ACTIVITIES

Spain Bulgaria Portugal Turkey Latvia Greece

Completion of
an online

document sent
by EduFor about

dissemination
activities carried

out

1 month
before each
transnationa

l meeting

X X X X X X

Assessment of
the project

communication
and

dissemination
activities

Before the
interim
report

X

Re-organisation
of the

communication
and

dissemination
strategy (if
necessary)

After
analyzing

the results
of this

evaluation
X

2.5.1 Still on the distribution of responsibilities

Unless it goes against their legitimate interests, each beneficiary must - as soon 

as possible - disseminate its results by disclosing them to the public by 

appropriate means (other than thoseresulting from protecting or exploiting the results), 

including in scientific publications (in any medium). Therefore, all possible opportunities 

must be tackled by individual partners or oncollective basis, through joint appearance by 

more than one partner, to spread the PreDys project among teachers, parents

and general public. 

EduFor will act as Dissemination Manager of the  project,  coordinating and 

supervising all the dissemination activities. On the other hand, all partners of the consortium will 

contribute to the dissemination tasks, according to their role and using all available tools and chan

nels.
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3 REPORTING ON DISSEMINATION ACTIVITIES

All activities performed by each partner should be recorded (eg in annex 0) for further information
to the responsible partner, EduFor. 1 month before each transnational meeting, an online form
will be sent to collect all dissemination activities carried out so far. Meeting the timing of each
dissemination activity will be one of the criteria for evaluating each partner's work with regard to
dissemination.

All event-related activities, including external events, article publishing and newsletters should be
made known to the dissemination partner, EduFor, using Annex 5.

As it is clear from this document, all activities undertaken should be disseminated through all the
possible means.

IN CONCLUSION

Regarding the importance of dissemination activities, we believe that there is no need to add
anything else. We only conclude by pointing out that activities that bring excellent results but
whose gains are limited in space and/or time do not, in fact, justify the huge investment that
project activities such as Erasmus Projects entail. Dissemination is also talk about accountability.
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ATTACHMENTS
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Project No: 2019-1-ES01-KA201-065691

Annex 0 - Dissemination Activities Checklist

DISSEMINATION

ACTIVITY FREQUENCY
2 ACTIVITIES DEVELOPED BY ALL PARTNERS

(INDICATE NUMBER OF ACTIVITIES AND LOCATION IF APPLICABLE)

PUBLICATIONS Dec.

201

9

Jan.

202

0

Mar.

202

0

Fev.

202

0

Apri

l

202

0

May

2020

Jun

202

0

Jul

202

0

Sep

202

0

Oct

202

0

Nov

202

0

Dec

20

Jan

21

Feb

21

Mar

21

April

2021

Apri

l

202

1

May

21

Jun

2021

Jul

21

Sep

2021

2 A - Once a week; B - Every two/three weeks; C - Once a month; D - Twice a month; E - At the end of each output (the more activities are done the better).

Dissemination Strategy



Facebook’s and

other social

media partners’

publications

B

Facebook’s

partners’

publications
A

Website’s

partners’/others

publications
A

Articles
(Send press

release to all
media accessible -
Annex 2) and then
keep evidence of
the publication of

articles

E
F

Flyers

For
dissemination
of the project
and specific

events

Partners’
Newsletter

Annex 3

D

Final handbook
for teachers

At the end of
the project

Final handbook
for teachers

At the end of
the project

Final handbook
for Principals

At the end of
the project

Final handbook
for Counselors

At the end of
the project

Transition Kit
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(No. Of
downloads)

DISSEMINATION

ACTIVITY DATE
ACTIVITIES DEVELOPED BY ALL PARTNERS
(INDICATE NUMBER OF ACTIVITIES AND LOCATION IF APPLICABLE)

EVENTS Dec.

201

9

Jan.

202

0

Mar.

202

0

Fev.

202

0

Apri

l

202

0

May

2020

Jun

202

0

Jul

202

0

Sep

202

0

Oct

202

0

Nov

202

0

Dec

20

Jan

21

Feb

21

Mar

21

April

2021

Apri

l

202

1

May

21

Jun

2021

Jul

21

Sep

2021

Replication of
training

Feb. 2021 -- -- -- -- -- -- -- -- -- -- -- -- --

Replication of
study visit 13

May 2021 -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Multiplier event
Sept.
2021

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

External events
Presentation of

project outcomes
at Educational

events
(The more

presentations the
better)

It depends

3 No time to replicate study visit 2.
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Project No: 2019-1-ES01-KA201-065691

Annex 1 - Event Press Release Template
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EVENT PRESS RELEASE TEMPLATE

[LOGO of Your Model System (optional)]

FOR IMMEDIATE RELEASE CONTACT: [Name]
[Date] [Phone Number]

[Email]

[MAIN TITLE OF PRESS RELEASE]

[SUBTITLE]
[CITY], [STATE] — [This is the Introduction paragraph about the event, a study, or other initiative
you want to publicize focusing on what is unique. To help generate interest from the news media,
you want to make it engaging and newsworthy with such information as the “Five W’s”—(W)ho,
(W)hat, (W)hen, (W)here, and (W)hy—when applicable.].

[Details in this paragraph should be an extension of the introduction. It should provide specifics
about the topic and mention of your Model System. This paragraph could include the following
sample sentence: The event/topic will feature research findings produced through the Model
Systems of the National Institute for Disability and Rehabilitation Research (NIDRR), <insert
example a>, <insert example b>].

[This paragraph could include quotes from someone with authority that comments about the
event/topic. Be sure to include their credentials. Quote could be followed by one sentence that
summarizes the comment, or highlights a positive characteristic about your topic relating to the
comment].

[This paragraph should provide more details, including how people can get involved with your
topic/event and generally how your topic can be integrated into a community, if possible. This
paragraph could be used to appeal to the social aspects of your topic. If there is a website link that is
different from that of your Model System, you should include it here.]

***

ABOUT [NAME OF YOURMODEL SYSTEM]
[Boilerplate language about your Model System; can include some completed studies that may
interest your audience]. For more information, visit [website link].
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Annex 2 – Flyer template
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WHO WE ARE

Don’t be shy! Let them know how great you are. This is the back
cover of your booklet, so it’s one of the first and last things the
recipient sees.

It’s a great place for your ‘elevator pitch.’ If you only had a few
seconds to pitch your products or services to someone, what
would you say?

● Consider including a couple of key takeaways on this back cover…

● Just remember that this is marketing—if you want to grab their

attention, keep it brief, friendly, and readable.

CONTACT US

If you have a physical location, provide brief directional
information, such as highways or landmarks:

[Street Address]
[City, ST  ZIP Code]

Phone: [Telephone]

Email: [Email address]

Web: [Web address]

PREDYS
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[Company Name]
[Street Address]
[City, ST  ZIP Code]

PROJECT NO: 2019-1-ES01-KA201-065691

SUPPORTING CHILDREN AT RISK OF DYSLEXIA AT THE TRANSITION

PERIOD FROM PRE PRIMARY TO PRIMARY
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Table of Contents
Overview of Programs 1

Getting Started 2

What to Include 2

Focus on What You Do Best 2

Don’t Forget the Mission 3

Make It Your Own 4

Customize in Almost No Time 4

Make It Picture Perfect 4

Our Products and Services 5

INTELLECTUAL OUTPUTS

PEDAGOGICAL FRAMEWORK

Wondering why the page number on this
page is 5? This is the inside back cover.

This booklet is setup to make it easy to
print a two-sided, eight-page booklet.

PREDYS TOOL KIT

The bottom of inside pages is setup for
you to manually add page numbers, so
it’s easy to adjust numbering for your
printing preferences. The table of
contents at left is also setup for manual
editing, so you can easily update page
numbers.

PILOTE TRAINING
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Save a copy of this booklet as a PDF file
for delivery to your printer or easy
printing on your computer. On the File
menu, click Print.

For two-sided printing, note that this
booklet is laid out to flip on the short
side of the page.
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Annex 3 – Newsletter template

Document quality is not good. However, all Partners will have access to improved quality documents.
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NEWSLETTER

TITLE

[DATE]

STORY HEADLINE

STORY SUBLINE

At any time, you can easily change the text of any section in this
document by simply clicking and typing.  The template is prepared so
that formatting stays in tact with the new information you include.

To update formatting, from the Home tab, you can use the Quick Styles
gallery for the built in styles.  You can also format text directly by using
the other controls on the Home tab.

On the Design tab, you can change the theme, the colors, and the fonts of
the document.  This will update the entire document to the main color
scheme and font scheme that you pick, with the click of a button!

To change any of the images, simply click on them and choose “Change
Picture” from the Picture Tool tab.  For the image on the first page,
double click in the header to access the image and update it as
necessary.

STORY
HEADLINE
Story Subline

For this side panel, include a few
highlights for another story or
some type of event you want to
highlight.  Highlight a teacher of
the week/month, or a
student/athlete of the
week/month.

Share with the audience what else
is further in the document.  Are
there school events coming up?  Is
there a band concert or sporting
event that the audience should
know about?

You can start a story here and
continue it on another page in the
newsletter if it pushes longer than
this space allows.

Make the newsletter your own!
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STORY HEADLINE

STORY SUBLINE

At any time, you can easily change the text of any
section in this document by simply clicking and
typing.  The template is prepared so that formatting
stays in tact with the new information you include.

To update formatting, from the Home tab, you can use
the Quick Styles gallery for the built in styles. You can
also format text directly by using the other controls
on the Home tab.

On the Design tab, you can change the theme, the
colors, and the fonts of the document.  This will
update the entire document to the main color
scheme and font scheme that you pick, with the click
of a button!

To change any of the images, simply click on them
and choose “Change Picture” from the Picture Tool
tab.  For the image on the first page, double click in
the header to access the image and update it as
necessary.

Another
Headline
Here

You can easily change the formatting of selected text in the document text by
choosing a look for the selected text from the Quick Styles gallery on the Home tab.
On the Insert tab, the galleries include that are designed to coordinate with the
overall look of your document. You can use these galleries to insert tables, headers,
footers, lists, cover pages, and other document
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Annex 4 – Dissemination status report

DATE OF THE ACTIVITY: ___/___/20___

DISSEMINATION STATUS REPORT
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To: EduFor

From:

Dissemination
Activity:

☐ Publications: __________________________________

☐ Events: ______________________________________

☐ External events: _______________________________

☐ Other event: _______________________________

Summary:

Note: Attach evidence (photos, newsletter, flyer, etc.
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